Release Notes for
Campus Manager 4.0 on Solaris

These release notes are for use with the Campus Manager 4.0 (Campus), part of
the CiscoWorks family of products running on a Solaris platform. Supported
Solaris versions are 2.8 and 2.9.

These release notes provide:
e New Features, page 2
e Product Documentation, page 4
e Related Documentation, page 6
e Additional Information Online, page 6
e Support Information, page 7
e Known Problems, page 7
e Resolved Problems, page 58
e Obtaining Documentation, page 60
¢ Documentation Feedback, page 61
e Obtaining Technical Assistance, page 61
e Obtaining Additional Publications and Information, page 63

c I S C 0 SY S T E M S Corporate Headquarters:

Cisco Systems, Inc., 170 West Tasman Drive, San Jose, CA 95134-1706 USA

® Copyright © 2005 Cisco Systems, Inc. All rights reserved.



Il New Features

New Features

Campus Manager 4.0 contains the following new features:

Ability to work with devices managed using ACS (Access Control Server).
Integration with CiscoWorks Homepage portal.
Enhanced support for virtual LAN (VLAN) and private VLAN (PVLAN).

Support for hosts running IPv6 and devices that may or may not have IPv6
configured on their interfaces.

Support for certain SNMPv3 features.
Support for Device and Credential Repository (DCR).
Licensing using the Common Services licensing framework.

Fixes to problems that existed in previous releases. For more information see
“Spanning Tree Protocol Known Problems” section on page 57.

In addition, the following enhancements have been made to individual Campus
applications. Topology Services

The new features in Topology Services support:

Creating PVLAN.

Managing workgroups that use VLANSs and segment your network logically.
Creating trunk.

Viewing port, device, and trunk attributes.

Displaying reports about inconsistencies or misconfigurations in your
physical or logical network setup.

Viewing and finding port information in a VTP domain and configuring
VLANS on a trunk.

Creating EtherChannel.
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Path Analysis

New Features W

The new features in Path Analysis allow:

User Tracking

Support for IPv6.

Analyzing paths between two specified Layer 2 or Layer 3 devices. It enables
you to use device hostnames or IP addresses, and show results in a network
view, table, or textual trace display.

Sorting Subnet-to-VLAN mapping table.

Displaying managed domain, and display the Layer 2 path, wherever
possible, between two specified end-user hosts known to User Tracking.

Displaying information about interface properties such as Maximum
Transmission Unit (MTU) size, speed, MAC address, and media type.

Displaying information about device properties such as node name, device
type, chassis type, up-time, and one alias.

Tracing paths that Voice over IP (VoIP) can take on data networks.
Saving and print path trace information.

Running CiscoView from supported devices displayed in the Path Analysis
view.

Running Visual Switch Manager from Cisco 1900, 2900XL, and 3500XL
devices displayed in the Path Analysis view.

Support for Cisco CallManager login.

The new features in User Tracking allow:

Discovering and displaying information about users, hosts, and IP phones in
your network.

Performing query for users, hosts, and IP phones.

Modifying, adding, and deleting the username and notes in the main User
Tracking table.

Highlighting devices on the Layer 2 view in Topology Services.
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Il Product Documentation

e Viewing reports about duplicate IP addresses, and duplicate MAC addresses
and VLAN names.

e New non-Java based lightweight user Interface.

Discrepancy Reports

The new features in Discrepancy Reports allow:
e Support for enhanced discrepancy reporting.

e Reporting on network inconsistencies, anomalies or misconfiguration in the
physical and logical layout in the discovered network.

Administration

The new features in Administration allow:
¢ Configuring the discrepancies and generate syslog messages.

¢ Administering Topology Groups, and schedule Path Analysis traces.

Product Documentation
~

Note  We sometimes update the printed and electronic documentation after original
publication. Therefore, you should also review the documentation on Cisco.com
for any updates.
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Product Documentation

Table 1 describes the product documentation that is available.

Table 1

Product Documentation

Document Title

Available Formats

Quick Start Guide for LAN
Management Solution 3.0

Printed document that was included with the product.

On Cisco.com at:
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/cw2000_b/Ims/

User Guide for Campus Manager
4.0

Printed document that was included with the product.

On Cisco.com at:
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt
/cw2000/camp_mgr/camp_4x/cmgr_4_0/rel_note/index.htm

Installation and Setup Guide for
Campus Manager 4.0 on Solaris

Printed document that was included with the product.
PDF on the product CD-ROM.

On Cisco.com at:
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt
/cw2000/camp_mgr/camp_4x/cmgr_4_0/sol_inst/index.htm

Printed document available by order (part number
DOC-78-16400-01=).!

User Guide for Campus Manager
4.0

PDF on the product CD-ROM.

On Cisco.com at:
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt
/cw2000/camp_mgr/camp_4x/cmgr_4_0/u_guide/index.htm

Printed document available by order (part number
DOC-78-16398-01=).!

Supported Devices Table for
Campus Manager 4.0

On Cisco.com at:
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt
/cw2000/camp_mgr/camp_4x/cmgr_4_0/index.htm

Context-sensitive online help

Select an option from the navigation tree, then click Help.

Click the Help button in the dialog box.

1. See the “Obtaining Documentation” section on page 60.
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I Related Documentation

Related Documentation
~

Note = We sometimes update the printed and electronic documentation after original

publication. Therefore, you should also review the documentation on Cisco.com
for any updates.

Table 2 describes the additional documentation that is available.

Table 2 Related Documentation

Document Title Description and Available Formats

User Guide for CiscoWorks Describes CiscoWorks Common Services, gives an overview of
Common Services 3.0 the applications that make up Common Services 3.0 and provides

conceptual information about network management.

This also describes common tasks you can accomplish with
Common Services. This document is available in the following
formats:

e PDF on the product CD-ROM.

e On Cisco.com at:
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt
/cw2000/cw2000_d/comser30/index.htm

e Printed document available by order (part number
DOC-78-16398-01).!

1. See the “Obtaining Documentation” section on page 60.

Additional Information Online

The following product specific information is available online:

¢ Incremental Device Update (IDU) contains updated files necessary for the
latest device support and fixes to known problems that are not available in

Campus Manager 4.0. If you are a registered user, you can download IDU for
Campus Manager from:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus
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Support Information

Support Information

Campus Manager 4.0 supports only US-English and Japanese versions of Solaris
Operating Systems. It does not support any other language version. Set the default
locale to US-English for US-English version and Japanese for Japanese version.

Known Problems

This section describes the known problems in this release:

~

General Notes and Known Problems, page 8

General Known Problems, page 9

Browser Known Problems, page 19

Path Analysis Known Problems, page 20

User Tracking Known Problems, page 27

Topology Services Known Problems, page 32

ANI Server Known Problems, page 49

Device/Agent Known Problems Impacting ANI Server, page 55
VLAN Port Assignment Known Problems, page 56

Spanning Tree Protocol Known Problems, page 57

m To obtain more information about known problems, access the Cisco Software
Bug Toolkit at http://www.cisco.com/cgi-bin/Support/Bugtool/home.pl
(You will be prompted to log into Cisco.com)
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Il Known Problems

General Notes and Known Problems

Note the following:

Your browser must be properly configured. If it is not properly configured,
Campus might not work correctly. See the Installation and Setup Guide for
Common Services on Solaris for information on properly setting up client
systems.

Campus requires a DNS server to function properly. Many commands operate
erratically or not at all, if there is no DNS server on the network.

Running Campus from a browser invoked from an x-window connection is
not supported. Install a browser on the client from which you wish to connect.

You can upgrade your operating system (OS) either before or after you
upgrade Campus. However, if you upgrade the OS after upgrading Campus,
you will not receive any OS-related patch warnings or service pack-related
warnings.

Verify that the latest version of all required OS patches, service packs, and
third-party device drivers are installed before proceeding with an OS
upgrade.

We recommended that any Windows 2000 server running Netscape Navigator
should not also be used as a client.

Visio Caveats:

— Do not export an entire topology map to Visio. Instead, select and export
particular devices or a segment of the network.

— After selecting Export to Visio, you must enter a filename in the Export
to Visio dialog box for the file Visio will generate.

— Before opening a topology map exported to Visio, you need to download
the cm_cisco.vss file and place it in the Visio/Solutions directory.

Release Notes for Campus Manager 4.0 on Solaris
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Known Problems W

General Known Problems

Table 3 General Known Problems

Bug ID Summary Explanation

None Cisco Catalyst 3500 series is Campus supports Cisco Catalyst 3500 series in IP
supported in I[P mode only. mode only. Cluster mode is not supported. If your

network has a Cisco Catalyst 3500 switch in
cluster mode, the links display incorrectly.

Workaround:

None.

CSCsb28190  |Campus Manager applications | Toplogy Services, Path Analysis, VLAN Port
fail to start in ACS mode. Assignment, and Discrepancy Report tasks fail to
start when you login to CiscoWorks in ACS mode.

This problem occurs when you assign a
CiscoWorks user to a group and when CiscoWorks
server is not present in that group.

Workaround:

When you assign a user to a specific group, ensure
that the CiscoWorks Server IP address is added to
that device group.

CSCsa80727 Launching of Campus Manager |Campus Manager Uls fail to open when the
UlIs fails. daemon manager is not restarted for a long period
of time.

Workaround:

Stop and restart the daemon manager.
Campus Manager Uls will now open properly.

Release Notes for Campus Manager 4.0 on Solaris
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Il Known Problems

Table 3

General Known Problems (continued)

Bug ID

Summary

Explanation

CSCsa65685

Online Help for Data Extraction
Engine has incorrect details.

Schema for User Tracking Data, Switch Data, and
Subnet Data are incorrect in the Online Help.

The servlet for exporting user tracking data is
incorrectly mentioned as CMExportServlet.

Workaround:

See Chapter Data Extraction Engine in the User
Guide for Campus Manager 4.0 on Cisco.com for
the correct information.

CSCsa65131

Campus Manager Data
Extraction Engine servlet
interface does not work.

The Campus Manager Data Extraction Engine
servlet interface (CMExportServlet) displays an
error when you try to export User Tracking Data.

The Online Help for Data Extraction Engine has
incorrect details on the servlet to be used for
exporting User Tracking Data.

Workaround:

Do not use the CMExportServlet to export User
Tracking data. Use UTExportServlet to export
User Tracking Data. See Chapter Data Extraction
Engine in the User Guide for

Campus Manager 4.0 on Cisco.com for more
details.

CSCsa65130

Online Help for Data Extraction
Engine refers to a non-existent
logfile element.

In the schema for payload file, the Online Help
refers to a logfile element which is non-existent. If
this schema is used, an error is displayed.

Workaround:

Do not use the logfile element in the payload file.
See Chapter Data Extraction Engine in the User
Guide for Campus Manager 4.0 on Cisco.com for
the correct schema for payload file.

Release Notes for Campus Manager 4.0 on Solaris
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Table 3

Known Problems W

General Known Problems (continued)

Bug ID

Summary

Explanation

CSCsa47864

After uninstalling Campus, the
application does not remove the
links to Campus from
CiscoWorks Homepage.

If you have enabled SSL on CiscoWorks server
and if you uninstall Campus, the links to Campus
Manager application are not unregistered from
CiscoWorks Homepage.

Workaround:

None.

CSCsa44629

Campus does not restore
Topology Map settings after
taking back up and restore in
another machine, which has
Campus 4.0.

Campus Manager does not save the changes to
layout style and background colors in Topology
Map settings, which were backed up in another
machine.

This occurs when you do the following:

1. Modify Topology Map settings in a machine
with Campus 3.3.

1. Back up and restore the files in another
machine, which has Campus 4.0.

2. Run Data Collection.
3. Start Topology Services.
Workaround:

1. Run
NMSROOT/campus/conf/upgrade/cm/topo/
2cm31maplayout.pl on the machine with
Campus 3.3 to generate the map files.

2. Copy the map files to the location on the target
system, where you have restored the data:
SNMSROOT/campus/etc/users/usernamel/

3. Upgrade Topology Map by selecting File >
Upgrade View Layouts from Topology
Services.
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Il Known Problems

Table 3 General Known Problems (continued)
Bug ID Summary Explanation
CSCsa29999 In Campus, User Defined group |[When you create Common Services User Defined
lists all the devices when you group in Device and Credential Repository (DCR)
create the group in CiscoWorks |Device Management, the User Defined Group in
Common Services. Campus displays all the devices.
Workaround:
None.
CSCsa22708 Campus does not manage This problem occurs because Campus performs a

existing devices when upgrading
from higher device limit to lower
device limit.

fresh discovery of the network to obtain the
devices and does not import them from the earlier
versions.

‘Workaround:

None.

i Release Notes for Campus Manager 4.0 on Solaris
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Known Problems W

Table 3 General Known Problems (continued)
Bug ID Summary Explanation
CSCin58202 Unable to get XML data using | The is because of an error in the applet where you
user defined queries or layouts, |create user defined query or layout.
u?tll you r.estaﬁ User Era;kllzlg The applet does not save the user defined query or
a terl creating the user define layout in the ANI Server until you close User
queries or layouts. T . .
racking window.
Workaround:
None.
CSCin43133 Install may fail because of Using Volume Management, vold mounts the
improper mount of CD-ROM. CD-ROM as /cdrom/cdrom0. cdromO is a link to
volume label of the CD-ROM.
For example cm4.0.
In normal circumstances, the link gets cleared
after the CD-ROM is ejected. However, if the link
is not cleared, when you mount another CD-ROM,
it is mounted as /cdrom/cdrom0, This is then
linked to cm4.0#1.
This # character causes problem during
installation.
To verify if the directory name has a # character
appended to its name, navigate to the
/cdrom/cdrom0 directory, and check the present
working directory using pwd command.
Workaround:
1. Eject the CD-ROM.
2. Stop the vold:
/etc/volmgt stop
3. Start the vold:
/etc/volmgt start
4. Delete the contents of /cdromO directory.
The CD-ROM should now mount normally.
Release Notes for Campus Manager 4.0 on Solaris
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Il Known Problems

Table 3 General Known Problems (continued)

Bug ID Summary Explanation

CSCin23883 Jobs created in Path Analysis or |If you have scheduled Path Analysis or User
User Tracking appear in the Job |Tracking jobs and then uninstall Campus, the jobs
Management page even after are not deleted from the CiscoWorks Job
uninstalling Campus. Management page.

Workaround;
Delete the Path Analysis or User Tracking jobs
from the Job Management page.

CSCdu51651 | You cannot select the first Under ATM if you create SPVC/SPVP/Advanced
template from the drop-down parameters, you cannot select the first template
box, when you create from the drop-down box. This is because the
SPVC/SPVP/Advanced traffic parameter fields are not populated.
parameters. Workarounds:

1. Go to Select/Edit and select the template.
2. Click OK.
Or
1. Select the second template
2. Select the first template.
CSCdt55303 Starting Campus application This problem occurs if you:

with the Print dialog box open in
another Campus application
results in error.

1. Select Print from active Campus application.

2. Start another Campus application, with Print
dialog box open.

The new application window does not respond
to user input.

Workaround:

Close the Print dialog box and restart the
application.

i Release Notes for Campus Manager 4.0 on Solaris
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Table 3 General Known Problems (continued)
Bug ID Summary Explanation
CSCdt42318 Cannot copy and paste IP This problem occurs if you:

addresses from Topology
Services to Path Analysis when
you use keyboard shortcuts.

e Enter Ctrl-C to copy address after selecting
an IP address in Topology Services,

Or

¢ Enter Ctrl-V with the cursor active in the
From field in Path Analysis.

e Inboth cases the following is pasted in instead
of the IP address:

java.lang.nullPointerException

Ctrl-X, Ctrl-C, and Ctrl-V (keyboard shortcuts for
cut, copy, and paste commands) are not supported
by summary tables in the Topology Services main
window or most tables displayed by Campus
applications.

Also, in applications that support the copying of
table cells by selecting Edit > Copy, a carriage
return is added to the end of the last cell copied.

Workaround:

None.

Release Notes for Campus Manager 4.0 on Solaris
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Il Known Problems

Table 3 General Known Problems (continued)
Bug ID Summary Explanation
CSCdt22462 Download of Java applets on On some Windows systems, the initial download

Windows 2000 machines may
take longer than expected if virus
checker application is enabled.

of large Java applets (or subsequent downloads of
the same applets that are not cached locally) might
take longer than expected (up to six minutes in
some instances).

After the applet has been loaded and cached
locally, the problem no longer occurs.

The delay is caused by client side filtering
mechanisms such as virus scanning. Some virus
scanners are configured to automatically scan
content downloaded by browsers. Scanning
consumes a lot of memory and results in disk
paging on most systems.

Hence, downloading is significantly slower than
expected. (The effect is less on systems with large
amounts of RAM and virtual memory.)

Workaround:

Disable the automatic scanning of all downloaded
files, and instead enable the scanning of program
files only (specified by file extension).

Exact instructions vary depending on the virus
scanner installed on your system.

Release Notes for Campus Manager 4.0 on Solaris
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Table 3 General Known Problems (continued)

Bug ID Summary Explanation

CSCds88388 Cannot launch CiscoView on an |This occurs if you:
IGX series device. 1. Launch Topology Services.
2. Open LAN Edge view.

3. Right-click on IGX series device and select
CiscoView from the Context menu.

A dialog box appears.

4. Enter appropriate community strings, and
CiscoView attempts to launch.

An error message appears.
Workaround:

Launch CiscoView on IGX series devices via
Cisco WAN Manager.

CSCdm88520 |Minimized windows are not If a window is minimized, you cannot make it
visible when you select them visible by selecting it from a Window menu.
from a Window menu.

Workaround:

e On Solaris, double-click the icon of the
window on the desktop.

e  On Windows, click the icon of the window in
the task bar.

Release Notes for Campus Manager 4.0 on Solaris
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Il Known Problems

Table 3 General Known Problems (continued)
Bug ID Summary Explanation
CSCdm8320 Campus applications do not If you access CiscoWorks applications using
work when you access http://localhost:1741 from a browser on the
CiscoWorks using same machine that CiscoWorks server is installed
http://localhost:1741 on, Campus suite of applications will not work.
Workaround:
Use full DNS name or IP address of server, even
when accessing it locally.
CSCdm77812 |In Path Analysis, Tools > Path  |If your system has a non-blank CLASSPATH

Trace displays an error,

null pointer exception ONn
Microsoft Internet Explorer 5.0
with the URL of a local host.

environment variable, your browser might behave
unpredictably.

Workaround:
Reset the CLASSPATH variable non-globally:

e Solaris— Reset the CLASSPATH variable
from the terminal window from where you
launch the browser.

e Windows—Reset the CLASSPATH variable in
MS-DOS prompt window and launch the
browser from the prompt.

Release Notes for Campus Manager 4.0 on Solaris
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Browser Known Problems

Table 4

Browser Known Problems

Known Problems W

Bug ID

Summary

Explanation

CSCin39472

Problems with Campus Manager
applications after logout.

When you logout from CiscoWorks, Campus
Manager applications will continue to function.
However, the following functions will not be
available:

e Launching Help.

e Tasks in Campus which require user action
between applications. For example,
highlighting a device in Topology Services
using Path Analysis.

Workaround:
1. Close all Campus applications.
2. Login into CiscoWorks.

3. Launch Campus applications.

CSCdt11838

You are not prompted to install
the Java plug-in when launching
an application that utilizes the
plug-in for the first time.

If RealJukebox Plug-in for Navigator is already
installed on a Windows client before the first
launch of application utilizing Java Plug-in, you
will not be prompted to install Java Plug-in.

Workaround:

Uninstall RealJukebox Plug-in. Another option is
to rename nprjplug.dll file in Navigator Plug-ins
directory with new extension—for example,
nprjplug.dil.bak.

After Java Plug-in is installed, you can reactivate
RealJukebox Plug-in by changing the renamed file
back to nprjplug.dll.

[ 78-16394-01
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Il Known Problems

Table 4 Browser Known Problems
Bug ID Summary Explanation
CSCdp43999 |Maps and configuration dialogs |Sometimes, when you launch a map or a
display offset menus and list configuration dialog box, menus or list boxes are
boxes in Netscape on a Solaris  |not displayed below the menu. This offset occurs
client. in Navigator on a Solaris client.
Workaround:

Move or resize window.

Path Analysis Known Problems

Table 5 Path Analysis Known Problems

Bug ID Summary Explanation

CSCsa47939 You cannot start CiscoView from |You cannot start CiscoView from Path Analysis
Path Analysis, on SSL server. because of an incorrect URL:

https://CiscoWorksServer:-1/CVng/
chassis.do?deviceip=10.77.209.53

Workaround:

Replace -1 with 443 in the URL, thus correcting
the URL to:

https://CiscoWorksServer:443/CVng/
chassis.do?deviceip=10.77.209.53

Release Notes for Campus Manager 4.0 on Solaris
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Known Problems W

Path Analysis Known Problems (continued)

Bug ID

Summary

Explanation

CSCsa41902

Campus does not display proper
error message when ACS is
down.

When ACS is down, authentication succeeds but
authorization to the server fails. Campus tasks
display an error message, which does not specify
that TACACS+ login has failed.

Campus must display an error message similar to
the message in Common Services:

Authentication with TACACS+ fails. You are
in the fallback mode. Please go to Server >
Security > Login Module > Non ACS to change
the Login Module to CiscoWorks Local. You
will need appropriate privileges to perform

this operation.

Workaround:

None.

CSCsa22380

Layer 2 Path Trace is not seen
between IPv6 End host as source
and its first hop IPv6 router.

In Path Analysis, when you run a Path Trace using
IPv6 address of the End host and some other IPv6
destination (say router), Layer 3 Trace is
observed. But, Layer 2 Trace (switches if any)
between End host and First hop router is not
shown in Path Trace.

Workaround:

None.

CSCin37960

VLAN-to-Subnet mapping
information is not available for
Phone Traces.

Path Analysis does not provide VLAN-to-Subnet
mapping information, when you run Path Trace
between two IP phones.

Workaround:

None.
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Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation

CSCin37938 Interface Type displays This problem occurs when you run path traces
Unknown for phones in Path between IP Phones or between a device and IP
Analysis Table. Phone.

Workaround:
None.

CSCin36082 Additional hop appears when An additional hop appears if you perform a trace
you perform a trace using HSRP |by providing an HSRP virtual IP address as the
virtual IP address. source or destination in the path trace.

Workaround:
None.

CSCin35773 Map displays self loop when Occasionally, when the potential first hop learnt

routing loop occurs. by Path Analysis is not discovered successfully by
ANI, the map displays a self loop.
Workaround:
None.

CSCin30899 Path Analysis does not work If you disable source route on routers, Path
when LSR Traceroute is Analysis might not display the route occasionally.
disabled. Workaround:

None.

CSCin28223 CORBA related error message is |Occasionally, during path trace, a CORBA related
logged into the log file during error message is logged into the ani.log file.
path trace. Workaround:

Close the client browser window and relaunch
Path Analysis.
CSCin00624 Path trace involving HSRP The problem occurs when you run a Path trace

router results in an empty If
Index entry in the Path Analysis
table.

which includes the IP address of an HSRP router
in the From field of a path trace.

Workaround:

None.

i Release Notes for Campus Manager 4.0 on Solaris
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Table 5 Path Analysis Known Problems (continued)
Bug ID Summary Explanation
CSCdw15555 | Voice trace fails to get Cisco Path Analysis Voice Trace needs to query call

CallManager cluster information |managers known to ANI to see what the cluster
if Cisco CallManager HTTPD membership is.

shuts down. This is done through a HTTP query

As a security precaution, you might disable the
Web Server on all cluster members except one.
This is because Cisco CallManagers use IIS, and
can be badly damaged by viruses such as Code
Red and NIMDA.

However, if cluster members have Web Server
shut off, then Path Analysis cannot obtain
information on cluster membership and cannot
retrieve CDRs.

Workaround:

Turn the Web Server on the Cisco CallManager
back on.

Release Notes for Campus Manager 4.0 on Solaris
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Table 5 Path Analysis Known Problems (continued)
Bug ID Summary Explanation
CSCdw03410 |Path Voice Trace does not Current Campus Path Analysis Voice Trace is

consider transcoding points.

valid only in the case where the two endpoints are
IP Phones registered with the same Cisco
CallManager cluster.

For other cases (involving transcoding), Path does
not get correct path information.

Examples:

e Phone call from IP phone to POTS phone off
H.323 gateway (e.g. 3640)

e Phone call from one Cisco CallManager
cluster to another.

In such a case the path would be:
a. From phone 1 to Cisco CallManager 1

b. From Cisco CallManager 1 to Cisco
CallManager 2 through H.323
inter-cluster trunk

c. From Cisco CallManager 2 to phone 2
e Phone call to gateway (PSTN, analog, etc.)

e Phone call to other servers (voicemail,
conference, etc.)

This is a very complex issue, and most likely will
require new instrumentation from telephony
servers, etc.

Workaround:

None.
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Path Analysis Known Problems (continued)

Bug ID

Summary

Explanation

CSCdt42600

To and From fields may not
function properly after selecting
Print in Path Analysis.

This problem is caused by Java Virtual Machine
bug. After you select Print in Path Analysis, the
To and From fields may not accept mouse focus, or
focus may appear in both fields, simultaneously.

Workaround:

Resize Java console window. If the problem
persists, close Path Analysis window and open
another window.

CSCdt42404

Trace tab displays cMT as time
zone, although server is set to
local time zone.

A number of Java bugs involve incorrect
interpretation of time zones. Usually, the correct
time zone appears if you set the local time zone to
the appropriate three-letter abbreviation—for
example, PST for Pacific Standard Time.

This problem is observed on Solaris clients with
TZ environment variable set to American/Tijuana.

Workaround:

If the TZ environment variable is instead set to
PSTS8PDT, then Java interprets local time zone
correctly.

CSCdt23712

Path Analysis displays the Elvis
module of Cisco Catalyst 6000
devices as unknown.

Since Path Analysis depends on ANI for its tracing
capabilities, if a device-related discovery problem
occurs in ANI, it results in an unsuccessful trace.

Workaround:

None.

CSCdt04978

Highlighted path trace in
Topology Services map may be
difficult to view.

It may be difficult to view highlighted path trace
in Topology Services map, especially you select
the Fit to Window view.

Workaround:

Zoom into Topology Services Map view by
selecting

Select All Highlighted Objects > Zoom to
Selected.

[ 78-16394-01
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Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation

CSCds79693 Voice trace query results always |Local time zone always appears in voice trace
appear using local time zone. query results, even if you select GMT time zone

when specifying call start time.
Workaround:
None.

CSCds77461 Call Detail Records (CDR) Multiple threads are launched to query every
query results are sometimes Cisco CallManager for information specified in
displayed after pressing Cancel. |user's CDR query.

Since all query activities can take a second or two
to cancel, query results sometimes continue to
appear even after you press Cancel.
Workaround:
None.

CSCds77438 Path Analysis Map tab does not |This problem mainly occurs when running both

refresh properly.

the client and the server on the same machine. It
occurs after running a large number of Path traces
on client browser.

Workaround:
Close browser and relaunch Campus.

We recommend that you run the client and server
on different machines. Doing so does not
eliminate this problem. However, it reduces its
occurrence because you need to run a large
number of traces before problem manifests itself.

Release Notes for Campus Manager 4.0 on Solaris
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Information displayed in a row might not reflect the most current network state.
This is because User Tracking discovery takes information from routers and

switches.

Since these switches collect their information at different times, the information
in a row reflects the state of the network or subnet at the time displayed in the Last

Seen field.

Table 6 User Tracking Known Problems

Bug ID Summary

Explanation

CSCsb17074 User Tracking does not discover
hosts connected to devices with

SNMPv3 credentials.

When you manage the devices Cisco

Catalyst 3750 and Cisco Catalyst 4000 with
SNMPv3 Credentials in Campus Manager, and if
there are end hosts connected to these devices, the
end hosts are not discovered and shown by User
Tracking.

Workaround:

None.

None User Tracking discovery could

span more than desired subnet.

When you start subnet discovery of user nodes,
devices in that subnet are marked for discovery.

Since switches support multiple VLANS,
discovery could span more than the subnet that
you selected. User Tracking could discover
additional end host nodes that are not in the
selected subnet.

Workaround:

Query only the required VLAN option in the
subnet discovery window.

[ 78-16394-01
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Table 6

User Tracking Known Problems (continued)

Bug ID

Summary

Explanation

CSCsa30812

Job reports are not available after
upgrading to Campus 4.0.

Reports for the jobs that are successfully
completed in Campus 3.3 are not available after
upgrading to Campus 4.0.

This is because of the change in format of the
Reports in Campus 4.0. In earlier versions of
Campus, job results were stored in plain text,
whereas in Campus 4.0, the results are stored in
serialized object.

Workaround:

None.

CSCsa27118

User Tracking Report displays
Port State as Static for dotlx
authenticated ports.

User Tracking Report displays Port State as Static
when an end host is connected to the switch port,
which is configured for dotlx authentication.

This is because the device populates vmVlanType
as Static for dotlx authenticated ports.

Workaround:

None

CSCsa22740

ARP entries are not fetched for
Cisco 3550-24 VLAN
Interfaces.

ARP entries are not fetched for Cisco 3550-24
VLAN Interfaces. Hence, IP Address is not
displayed in User Tracking End Host Reports.

Workaround:

None.

CSCsa20659

Purge Job is created although
you delete it from User Tracking
Report Jobs.

In User Tracking, Purge Job is created even if you
try to delete it from the User Tracking Report Jobs
and Common Services JRM pages.

It gets deleted and then recreated immediately.
There is no functionality loss because of this.

Workaround:

None.
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Table 6 User Tracking Known Problems (continued)

Bug ID Summary Explanation

CSCsal4652 NAM and IDS Modules appear |Cisco Catalyst 6000 devices running native IOS
as end hosts in User Tracking. service modules are displayed as end hosts in User

Tracking.

This is caused by a problem on the device.
Workaround:

None.

CSCin08287 User Tracking does not In a network using DHCP, with the UTIPChange
recognize change in IP address |[setto 1, User Tracking does not recognize changes
UTIPChange is set to 1 under in IP address when an end-host is moved across
DHCP. VLANS. In this case, IP address changes across

subnets.

When you set UTTPChange to 0, User Tracking
detects the change of IP address across VLAN:Ss.
Workaround:

None.

CSCin00365 A change of Cisco CallManager |Cisco CallManager entries themselves respond
registration adds a new record in |with two entries. Make the change in the Cisco
phone table. CallManager and not in the User Tracking.

Workaround:
None

CSCin00363 End host does not appear if If you connect a CDP device to the port and then
obsolete ANI device IP address |add a new end host, this new end host is not learnt.
is assigned. This is because ANI is not aware of such a change.

Workaround:
Do the following:
1. Delete the specific device.
2. Perform device specific discovery.
3. Perform a User Tracking discovery.
Release Notes for Campus Manager 4.0 on Solaris
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Table 6 User Tracking Known Problems (continued)
Bug ID Summary Explanation
CSCin00181 Last Seen field gets updated for |The Last Seen field in Phone Tracking
disconnected IP phones. corresponds only to the Last Seen field on Cisco
CallManager and not to the Last Seen field on
Network.
Workaround:
None.
CSCec59408  |Campus does not query In User Tracking, configuring port security for a
CISCO-PORT-SECURITY-MIB |port makes the CAM entry static. When port
to verify port security security is configured, Campus does not query
configuration. CISCO-PORT-SECURITY-MIB.
This is because of a device specific MIB
implementation problem.
Workaround:
Upgrade to Cisco IOS Release 12.2(18)EW1 or
12.2(20)EW.
CSCdw04499 |End hosts are not discovered End hosts are not discovered with Catalyst 3550
with Catalyst 3550 running XL running Cisco IOS release 12.1(4)EA1 and
Cisco IOS Release 12.1(6)EA1 |Cisco IOS release 12.1(6)EAL.
or earlier. Workaround:
This problem has been fixed in Cisco IOS
release 12.1(6)EAla. Upgrade to this version.
CSCdw04486 |End hosts not discovered with End hosts not discovered with Catalyst 2950

Catalyst 2950 running a software
release earlier than Cisco 10S
Release 12.0(5)WC2.

running a software release earlier than Cisco [0S
Release 12.0(5)WC2.

Workaround:

This problem has been fixed in Cisco IOS
Release 12.0(5)WC2. Upgrade to this version.
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User Tracking Known Problems (continued)

Bug ID

Summary

Explanation

CSCdt25525

User Tracking main table
sometimes displays
CDP-enabled devices that are
outside the ANI discovery
boundary.

During User Tracking discovery, User Tracking
reads entries from the CAM table. These entries
may include MAC addresses of devices that fall
outside the ANI discovery boundary.

Workaround:

None.

CSCdt06183

User Tracking Main Table may
not display all entries that are
displayed in the phone table.

User Tracking entries shown in the main table are
discovered from network. However, User Tracking
entries shown in the phone table are read from
Cisco CallManager.

If User Tracking cannot discover particular
phones in network, entries for such phones in the
User Tracking phone table will not have device
and port information.

Workaround:

None.

CSCdr85384

Phone entries displayed by User
Tracking differ from entries
displayed by Cisco CallManager.

User Tracking phone entries acquired through
SNMP for each Cisco CallManager may be
different from entries in Cisco CallManager.

The Cisco CallManager database displays a
historical record of all phones registered to Cisco
CallManager.

The SNMP agent retains only records of phones
registered since the agent was started. This
accounts for any differences.

Workaround:

None.
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Topology Services Known Problems

Table 7 Topology Services Known Problems
Bug ID Summary Explanation
None Multilayer Switch Module Multi-layer Switch Module does not have the MIB
gigabit ports displayed as to support half and full-duplex on gigabit ports.
unknown-duplex. Therefore, those ports are displayed as
unknown-duplex.
Workaround:
None.
CSCsa78413 Hostname resolution does not Campus Manager does not display hostnames for
work on Windows 2003. devices or end hosts although DNS support is
configured, and working properly.
This occurs when CiscoWorks is running on
Windows 2003.
Workaround:
None.
CSCsa80409 Campus Manager Telnet and Telnet and SSH fail to launch from the Campus
SSH do not support Windows Manager Topology Map.
2003 and XP clients This occurs on Windows 2003 and Windows XP
clients.
Workaround:
None.
CSCsa39618 Unable to close Topology Java console hangs when you select File > Close

Services and Path Analysis.

option from Menu in Netscape 7.1 on Microsoft
Windows.

Workaround:

Click the Close button (X) on the right hand corner
of the window.
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Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation

CSCsa37595 Unable to delete large number of |An error message appears when you try to delete
devices from Topology Services. |more than 100 devices from VTP Domain View in

Topology Services.

Workaround:

We recommend that you restart the database
without deleting large number of devices through
the User Interface.

CSCsa36666 Internet Explorer client on Internet Explorer on Microsoft Windows 2003
Microsoft Windows 2003 erases all the characters before the character @,
displays wrong title for and displays the rest of the title.

Topology Services Workaround:
None. This does not cause any loss of data or
affect the functionality.

CSCsa27318 Topology Services displays an  |When you save the layouts and re-start topology
outOfMemoryError, while map after using Topology Map tools such as zoom
working with 3000 devices. and drag, Java console displays an error:

java.lang.OutOfMemoryError.

This is because of low memory in profiles
directory, where the jar files are being
downloaded.

Workaround:

Make sure that there is enough memory in the jar
cache partition.

CSCsa25203 Campus does not generate Time |Campus displays an empty report when you run
Domain Reflectometry (TDR) TDR test on Cisco 3750 and Cisco 4500 series
Report for Cisco 3750 and Cisco |switches.

4300 series switches. This is because MIBs are not available to support
TDR feature on these devices.
Workaround:
None.
Release Notes for Campus Manager 4.0 on Solaris
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Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation

CSCsa24985 Topology times out after a brief |In Topology Services, after a brief period of
period of inactivity. inactivity, when you launch port attributes from

the map, it displays an Authorization Error.
Workaround:
None.

CSCsa22699 Inter-VLAN Routing Inter-VLAN Routing configuration user interface
configuration user interface (UI) [shows multiple entries for the same interface when
does not differentiate primary you configure primary and secondary IP addresses
and secondary IP addresses. for SVI or sub-interfaces. The UI does not clearly

differentiate the primary and secondary IP
addresses.

Workaround:

This problem does not occur in Cisco IOS Release
12.1(20)E3 or later.

CSCsal8405 In PVLAN configuration, the In devices with Cisco Catalyst Operating System

secondary VLAN creation and
association to Primary VLAN
fail on Cisco Catalyst Operating
System version 8.1.

version 8.1, Secondary VLAN creation and
association with Primary VLAN fail if the device
is running on version VTP version 3.

Workaround:

Either:

e Upgrade to Cisco Catalyst Operating System
version 8.2.

Or

e Change VTP version to 2 and VTP mode to
transparent.
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Topology Services Known Problems (continued)

Bug ID

Summary

Explanation

CSCsal2448

Channel mode is set to desirable
on one end, and auto on the
other.

This can be seen in switches running Cisco 10S.
Channel mode is set as desirable on one end, and
to auto on the other end.

Though this combination is valid and the link gets
converted to a channel, it has to be set to desirable
on both sides.

Workaround:

None.

CSCsal2292

VLANSs are not loaded for STP
Offline Computation.

This problem occurs in Topology Services
when you:

1. Launch STP Offline for PVST From the
Topology Map.

2. Go to Reports > VLAN STP >
Recommendations > STP Offline

3. Click Select Instance.
No VLANS are loaded.

Devices not supporting
CISCO-STP-EXTENSIONS-MIB will not
support any STP related functionality.

Workaround:

None

CSCsall888

Channel or Trunk cannot be
configured due to STP
recalculation.

Campus sets the channel mode to Desirable
Non-silent on the selected devices to be
channelled. However, STP state changes occur
when any mode change happens.

So, if one of the two devices of the channel is an
end-device and is only reachable through the
to-be-channelled links, the device cannot be
reached until the spanning-tree converges.

Workaround:

None.
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Table 7

Topology Services Known Problems (continued)

Bug ID

Summary

Explanation

CSCsal0216

Incorrect VTP version displayed
in VTP reports.

This problem occurs in Topology Services:

The VTP Report displays the VTP version as 1
while the actual VTP version running on the
device is VTP version 2.

This issue is seen only with some of the Cisco
Catalyst platforms such as C4506, C3750G,
C2900.

Workaround:

None.

CSCsa04026

Link line or connection between
two devices gets warped, if one
is moved.

This problem is seen in Topology services display
map. When there is a long line between devices
and one of the device is dragged to a different
location on the map, a kink in the line develops
with the link line connecting these two devices
getting warped.

The line appears jagged, instead of being straight.
Workaround:

To avoid this behavior, have devices closer to each
other.

CSCin68983

Cannot configure Trunk between
Cisco 2900XL and Cisco
3500XL devices.

Trunk configuration fails between Cisco 2900XL
and Cisco 3548XL series switches.

This is due to lack of MIB support.
Workaround:

None.
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Topology Services Known Problems (continued)

Bug ID

Summary

Explanation

CSCin68382

Tasks related to Network
Administrator role are not
properly reflected in ACS.

This problem is found when a user in ACS server
is associated with Network Administration role.

When a comparison is made between tasks defined
for Network Administrator role in CiscoWorks
LMS and that in ACS shared profile components,
some authorized tasks are found deselected for
ACS shared profile components.

Workaround:

None.

CSCin48159

Cannot launch IDSM from
Service Modules launch point
for IDSM2 card of Cisco
Catalyst 6000 device.

From Topology Services, you cannot start IDSM
using the Service Module launch point. This is
because of a defect in SNMP agent of the device.

Workaround:

None.

CSCin46641

Campus does not calculate Trunk
mode related discrepancies.

Topology Services does not flag the following
discrepancies for Cisco Catalyst 2900 series, 3500
series, and 4000 IOS devices, in Trunk mode.

e AutoTrunk
e NoTrunk
e TrunkNegotiationEnabled

This is because of the lack of MIB support in the
devices.

Workaround:

None.
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Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation

CSCin46405 Campus does not report Campus does not report the following Spanning
Spanning Tree discrepancies for |Tree discrepancies for some devices:
some devices. e BackboneFastDisabled

¢ UplinkFastDisabled
e BPDUGuarDisabled
e STPEnabledOnAccessPorts
This is because of lack of MIB support in the
devices.
Workaround:
None.

CSCin46370 Trunk Negotiation Enabled TrunkNegotiationEnabled Discrepancy Report
Discrepancy Report does not does not show Trunk mode details of the ports on
show the Trunk mode details of |Cisco Catalyst 2950, Cisco Catalyst 3550, and
the ports of some devices. Cisco Catalyst 4000 IOS devices.

This is because of a defect in SNMP agent of the
device.
Workaround:
None.
CSCin45496 Campus does not report UDLD |Discrepancy Reports does not display UDLD

discrepancy for Cisco Catalyst
2900 series switches.

disabled discrepancy for Cisco Catalyst 2900
switches.

This is because of a defect in SNMP agent of the
device.

Workaround:

None.
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Topology Services Known Problems (continued)

Bug ID

Summary

Explanation

CSCin45070

Launch points do not work if
http/https ports have other than
the default value.

In Topology Services, the launch points for
Service Modules function only if the http/https
port numbers are set to their default value.

Launch Points must function for any valid
http/https port number configured on the service
modules.

Workaround:

None.

CSCin43965

Spanning Tree reports more than
one root for a switch cloud.

Spanning Tree reports more than one root for a
switch cloud containing Cisco 2900XL, Cisco
3500XL, Cisco 2950, or Cisco 3550 devices, if the
selected VLAN is not assigned to any of the ports
in these devices.

This is because of a defect in SNMP agent of the
devices.

Workaround:

None.
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Table 7 Topology Services Known Problems (continued)
Bug ID Summary Explanation
CSCin36988 Cannot calculate utilization of  |This problem occurs in Topology Services when
VCs in tunnel. you:
1. Setup a tunnel between two ATM devices and

let the devices see each other as Interim Local
Management Interface (ILMI) neighbors on
their tunnel interfaces (subinterfaces) only.

2. Select Fabric view.

3. Select a device and its associated VP tunnel
link.

4. Select Tools > Display VCs > Per device.

5. Click Get Info.
An error is displayed:
Failed to compute utilization for some
or all rows

Workaround:

None.
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Topology Services Known Problems (continued)

Bug ID

Summary

Explanation

CSCin36950

Cannot view VCs in a tunnel
from Topology Services main
window.

This problem occurs in Topology Services when
you:

1. Setup a tunnel between two ATM devices and
let the devices see each other as Interim Local
Management Interface (ILMI) neighbors on
their tunnel interfaces (subinterfaces) only.

2. Select Fabric view.

3. Select a device and its associated VP tunnel
link.

4. Select Tools > ATM Management > Display
VCs > Per device.

The device or port chooser does not list
subinterfaces.

Workaround:

None.

CSCin30389

On Netscape Navigator, for
System Defined Groups, the
Create, Edit, and Delete buttons
appear enabled for all users.

When you click Create, Edit, or Delete buttons
even without permissions, the Admin client
displays a message saying that you do not have
access rights.

Workaround:

None.

CSCin29281

Device Attribute of Cisco
Catalyst 6000 devices does not
display the IP address.

Device Attribute of Cisco Catalyst 6000 devices
does not display the IP address of WS-X6624-FXS
module.

Instead, Device Attribute displays the IP address
of Supervisor engine.

This is because of a defect in the SNMP agent on
the device. For more details, see CSCin33075.

Workaround:

None.
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Table 7 Topology Services Known Problems (continued)
Bug ID Summary Explanation
CSCin27895 Topology Services does not Topology Services > VTP Domains > NULL
show VLANS as active, if the folder shows VLANSs in VTP server devices as
switch is in NULL folder under |inactive, if the VTP Domain name is not
VTP Domain. configured on the device.
Topology Services displays the VLANS as inactive
although the state of the VLAN on the switch is
active.
Workaround:
Either:
e Configure VTP domain name in the device
and rediscover.
Or
e Configure VTP domain mode of the device as
transparent and rediscover.
CSCin22459 Topology Groups membership  |This problem occurs in Topology Services when

update does not work as
expected.

you:

1. Launch Custom Views for a group by
selecting Campus Manager > Topology
Services.

2. With the Custom Views window open, Delete
a device group using Topology Group
Administration.

Custom View does not update automatically.

Workaround:

Reopen the Custom View window.
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Table 7 Topology Services Known Problems (continued)
Bug ID Summary Explanation
CSCin01977 Position of devices connected to |Switch clouds and fabrics represent the collection
Switch Cloud changed after of LAN switches and ATM switches, respectively.
upgrade. These logical entities are very specific to the
currently discovered network. That is, if there is a
new switch discovered, it can affect either of them
to a very large extent.
This means that you cannot uniquely identify a
switch cloud/fabric across ANI databases.
Workaround:
None.
CSCin01451 Cannot launch Customer This problem occurs when you launch Service
Response Application (CRA) Attributes from Topology Services. The
URLs from Service Attributes sysApplInstallPkgLocation MIB returns
window. /AppAdmin/.
The server http://ip-address/AppAdmin does not
start the application.
This is because the application Web Server was
running in a different port 6293.
Workaround:
Use CRA version 3.0(0.25) or later.
CSCin00665 Voice Port information not This is caused by a bug in the agent on the device
shown for Catalyst 4224 running |(Bug ID CSCdu08256).
a Cisco IOS release earlier than .
Workaround:
release 12.1(5)YE3.
This problem has been fixed in the Cisco I0S
release 12.1(5)YE3. Upgrade to this version.
Release Notes for Campus Manager 4.0 on Solaris
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Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation

CSCef67937 Campus does not show port as This problem occurs when Cisco Catalyst 3750
trunking if the port is part of the |has a 12.1 EA software version.

Channel. When a port is part of channel and configured as
trunk, Campus does not display the port as
trunking for Cisco Catalyst 3750 switches.
Workaround:

Upgrade Cisco Catalyst 3750 device to
12.2(18)SE1 or later.
CSCef35313 Campus does not show Gigabit |Campus does not show Gigabit ethernet port
ethernet port information for information for Cisco Catalyst 4000 and Catalyst

Cisco Catalyst 4000 and Catalyst 4500 series switches, running Cisco IOS Release

4500 series switches. 12.1(19) EW, 12.1(19) EWO01, or later.

This is because of a change in MIB

instrumentation.

Workaround:

To display the port information, insert a GBIC

(GigaBit Interface Converter) into the container.
CSCeb68819  |Topology Services does not When two devices with dual links are aligned

display dual links.

vertically on top of each other, the co-ordinates of
the vertices of both links become the same.

If the devices are not vertical, Topology Map
displays dual links.

Workaround:

Relayout the maps using hierarchical or
symmetrical layout, so that the devices do not
align vertically.
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Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation

CSCea39271 Topology Services displays the |CiscoWorks discovers Cisco Catalyst 4700 and
devices connected to a UB Catalyst 4500 devices, but displays them under
Token-Ring Hub in the Unconnected Devices View, and not in Layer 2
Unconnected Devices View. View.

Campus cannot draw the map for the devices, as
the routers are connected through a UB hub.

Workaround:

None.
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Table 7 Topology Services Known Problems (continued)
Bug ID Summary Explanation
CSCeal7100 |Topology Group Administration |When you use Internet Explorer 6.0 with Service

not accessible using Internet
Explorer 6.0 with Service Pack 1
(version 6.0.2800.1106).

Pack 1 (version 6.0.2800.1106), in the non-SSL
mode, applets under Campus Manager >
Administration > Topology Groups, appear as
blank grey boxes.

Also, output in the Java Console displays
IOExceptions when these applets are invoked.

Workaround 1:

If you do not want to enable SSL on the
CiscoWorks Server:

1. Invoke CiscoWorks Server and then Choose
any of the Common Services Applets (Back
up Database or Restore Database, Licensing
Information etc).

If the server uses a self-signed Certificate
(default), a message appears

The Certificate is issued by an
untrusted site...Do you want to Proceed?

2. Select View Certificate Option.

3. In the Certificate dialog box, select Install
Certificate.

4. In the Certificate Import Wizard, select the
default options.

5. Close the browser.
6. Invoke the CiscoWorks Server again.
Workaround 2:

1. Enable SSL on the CiscoWorks Server (Server
Configuration > Administration > Security
Management > Enable/Disable SSL).

2. Invoke Common Services Applets.
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Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation

CSCdw49136 |Campus cannot establish Initially, VLAN and ELAN are connected in
connection between ATM ELAN |Topology Services. When you remove LEC from
and Ethernet VLAN when you |Cisco Catalyst 2900XL devices, the connection
remove LEC from Cisco Catalyst |between VLAN and ELAN is broken for 2900XL
2900XL devices. devices.

This is because of a bug on 2900XL agent devices,
where it does not support CISCO-LEC-EXT MIB.
Workaround:

None

CSCdv41860  |Fetching LANE component In Topology Services, if you create a LANE
details displays an error component in an ATM switch (LS1010) and
AniSQLException. launch its view, all the Profile and Diagnosis menu

items related to this component display the
following error:

Internal error

Workaround:

None.

CSCdt50619 Two devices, connected by When two devices are connected by multiple links,
multiple links, appear to be deleting and you rediscover either devices or links,
connected by only one link. all of the links are stacked on one another.

This causes the devices to appear as if they are
connected by only one link.
Workaround:
Perform a re-layout.
Release Notes for Campus Manager 4.0 on Solaris
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Table 7

Topology Services Known Problems (continued)

Bug ID

Summary

Explanation

CSCdt27824

Entire list of ports in a VTP
domain appear when you select
certain Transparent VTP
domains from the VLAN
Assignment dialog box.

When similar VLAN definitions exist on a VTP
server and transparent devices, VLAN is added
under the parent folder and all transparent devices.

Thus, VLAN ports appear under all transparent
devices.

Workaround:

Run Find ports query and enter only device
name/address to view ports for a particular device.

CSCdt18293

Visio drawing does not import
cleanly into Microsoft Visio.

If you export a Topology map as a Visio drawing,
it is not imported cleanly into Microsoft Visio.

Links are drawn out of place, and some incorrect
links appear to be drawn between devices.

Workaround:

Clean the Visio drawing manually after import.

CSCdr11577

Virtual Circuit (VC) error chart
is blank.

A blank chart could mean either a continuous
polling failure or a failure caused by other
problems.

For example, a blank VC error chart might be
caused by a continuous polling failure (of VC
error related data).

It could also be because these statistics may not be
supported on certain image versions of the ATM
switch, being polled.

Workaround:

None.

CSCdp88318

Link attributes are not updated
after a change is made.

If you change link attributes, ANI Server does not
properly discover and display the change in
reports.

Workaround:

To update link attributes, close and relaunch
Topology Services.

i Release Notes for Campus Manager 4.0 on Solaris
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ANI Server Known Problems

Table 8 ANI Server Known Problems

Bug ID Summary Explanation

CSCsa31538 Campus cannot synchronize  |When a large number of devices are updated or
with Device and Credential deleted from DCR, Campus cannot synchronize with
Repository using DCR events. |DCR using DCR events.

Workaround:

Run Data Collection from Campus which will
synchronize all devices and related information in

DCR.
CSCsa20827 Subnet based groups are not  |In DCR, if you delete all devices or all devices in a
deleted from Campus subnet, the corresponding subnet based groups in
Topology Groups although Campus are not deleted immediately.
you delete them from DCR. Workaround:

If you want the subnet groups to be deleted earlier
than 20 minutes, change the property from:

SubnetPollerConfigTime = 1200000
to a lesser value in the properties file:

NMSROOT/MDC/tomcat /webapps/campus/WEB-INF/cla
sses/CM_Implementation_Details.properties.

Release Notes for Campus Manager 4.0 on Solaris
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Table 8 ANI Server Known Problems (continued)

Bug ID Summary Explanation

CSCsal9337 ANI goes into Unknown State |This problem occurs in ANI when you:

when you delete all devices
from DCR.

1.

Discover some devices by specifying seed
devices in Campus.

The DCR is updated with those devices.
Run data collection on those devices.
Invoke Topology Services.

Devices appear in Views.

Deleting all devices from DCR will show ANI state
and UT state as Unknown although you specify the
seed devices in Device Discovery settings.

Workaround:

None.

CSCin74855 Device not managed in This problem is seen in ANI.

Campus if management IP is
not in ACS.

If a device has multiple IP addresses, Campus
automatically determines the management IP
address of the device. If the management IP address
is not ACS (that is, the device is added in ACS with
a different address), then this device is not managed
in Campus. Data collection is not done for this
device.

Workaround:

IP address in ACS and management [P address in
DCR should be the same.

i Release Notes for Campus Manager 4.0 on Solaris
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Table 8 ANI Server Known Problems (continued)
Bug ID Summary Explanation
CSCin74855 Device not managed in This problem is seen in ANI.
Cazlglsls if management IP not If a device has multiple IP addresses, Campus
mn ’ automatically determines the management IP
address of the device. If the management IP address
is not ACS (i.e., Device is added in ACS with a
different address), then this device is not managed in
Campus. Data collection is not done for this device.
Workaround:
IP address in ACS and management IP address in
DCR should be same. Only then Campus will
manage and the authorization can be performed.
CSCin33112 Cannot delete devices on a The pelete pDevice command fails if you use it on
remote system in SSL mode a remote server in the SSL mode.
using the command line Workaround:
interface. '
None.
Release Notes for Campus Manager 4.0 on Solaris
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Table 8 ANI Server Known Problems (continued)
Bug ID Summary Explanation
CSCdz11668 |ANI Discovery causes If you install Campus on Solaris 2.8, the database

interfaces to go down.

interfaces go down shortly after beginning
discovery.

This causes the browsers to stop communicating
with the CiscoWorks server. The interfaces while
being displayed as UP in ifconfig, do not appear
when you enter netstat -rn.

This problem is caused by a Solaris bug; Sun Alert
ID: 48601: Solaris 8 and Solaris 9 Network Interface
may Stop Responding to TCP Traffic.

This problem occurs in the following releases:
e Solaris 8 with patch 108528-16, or

e Solaris 8 with patch 108528-17 but without
patch 113652-01

Workaround:

e Downgrade to kernel patch 108528-15 or earlier
and restart the system.

Or

e Disable the ANIServer process allows
CiscoWorks to continue functioning without
Campus applications.

The Sun bug mentioned above is resolved in Solaris
8 with patch 108528-17 and patch 113652-01 (for
use with patch 108528-17 only).
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Known Problems W

ANI Server Known Problems (continued)

Bug ID

Summary

Explanation

CSCdw67129

Topology Services cannot
resolve the histamine of newly
discovered devices.

If you add the DNS entry for the devices after initial
discovery, Topology Services cannot resolve the
hostname of the newly discovered devices.

The subsequent discoveries do not resolve the IP
address to a hostname until the ANIServer reloads.

This occurs only in devices that do not have a DNS
entry before discovery. Devices that have a DNS
entry before ANI discovers them, do not have this
problem.

Workaround:
Do either of the following:

e Restart CiscoWorks Server. ANI resolves the
IP address to a hostname after restart.

Or

e Display the sysName in Topology Services
(does not require a restart). Select:

Topology Services > Layer 2 View > View >
Display Labels > Show Sysname

Alternatively, you can do any of the following:
e Run the ANI discovery again.
e Stop and start the ANIServer.

e If you require Campus to ignore the cache and
always look up the DNS server, add the
following variable in the Java command line of
the ANIServer:

Dnetworkaddress.cache.ttl=0

[ 78-16394-01
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Table 8 ANI Server Known Problems (continued)
Bug ID Summary Explanation
CSCdt20329 ATM switches, for which This problem occurs when you:
Remote Monitoring (RMON) .
1. Select Topology Services.
is enabled, are not highlighted POTOBY
when Show Enabled Devices | 2. Highlight an ATM fabric under Managed
is selected. Domains/ATM Domains
3. Select Display View.
4, Select devices, and click Tools > RMON Data
Collection > Show Enabled Devices
Workaround:
None.
CSCdr84799 Applications do not function |Applications do not function across Network
across Network Address Address Translator (NAT).
Translator (NAT). Workaround:
None
CSCdp76410 |Campus client cannot connect |Common Services does not support proxies.
to server using proxies. Workaround:
None
CSCdm58624 |Campus reports VTP Campus reports Disconnected Domain discrepancy
Disconnected Domain even when VTP domain is configured across ATM
discrepancy when VTP cloud and the default ATM-VLAN is configured to
Domain is configured across a |carry VTP advertisements across the cloud.
LANE Trunk. Workaround:
Ignore the discrepancy.
CSCdm48015 |An ATM trunk port is shown |In VLAN-to-port association, all ATM ports on

as belonging to a VLAN, even
if there is no corresponding
LANE client associated with
that VLAN.

switches (except ATM switches) belonging to
VLAN will appear.

Workaround:

Ignore ATM ports in VLAN-to-port association.
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Device/Agent Known Problems Impacting ANI Server

Table 9 Device/Agent Known Problems Impacting ANI Server
Bug ID Summary Explanation
CSCin05978 ANT upgrade failure. A message appears that ANT upgrade has failed
when upgrading ANI in machines with Common
Services and Resource Manager Essentials installed.
This happens because the ANI server is not active
and no data is available for ANTI upgrade.
Workaround:
None. This error message does not affect the
functionality
CSCdp00593  |SNMP report displays wrong |This is because the image has reached EOE.
HwVersion and .
. . ) Workaround:
HwVersionMinor for Cisco
LS1010 devices. Enter show hardware in command line interface of
Cisco LS1010 devices.
CSCdm91634 |In Campus device report, This problem, which occurs in Catalyst 5000 devices
number of ports in a device’s |running Catalyst operating system software
ATM module are incorrectly |release 4.3(1a), is caused by missing if Entry for
displayed as zero. device ATM module.
ANTI Server depends on ifEntry to determine number
of ports in a particular module.
Workaround:
None.
Release Notes for Campus Manager 4.0 on Solaris
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VLAN Port Assignment Known Problems

Table 10 VLAN Port Assignment Known Problems

Bug ID Summary Explanation

CSCin67286 Topology Services cannot If the ports are inactive Topology services does not
populate PVLAN to port show PVLAN to port association in Cisco Catalyst
association, for ports that are |4000 IOS devices.
inactive in Cisco Catalyst

Workaround:
4000 10S devices. !
None.

CSCin67286 Port to PVLAN association in |In Catalyst 4000 IOS devices, the PVlan to port
Cat 4000 IOS not populated  |association is not populated properly, if the ports are
for down ports. in down state.

Workaround:
None.
CSCdw09818 |Port Attribute in VLAN Port  |Port Attribute displays incorrect information only

Assignment displays incorrect
information.

for the ports that are inactive in VLAN Port
Assignment.

This is because of a defect in SNMP agent of the
device.

Workaround:

None.
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Spanning Tree Protocol Known Problems

Table 11 Spanning Tree Protocol Known Problems

Bug ID Summary Explanation
CSCsal2292 VLANS not loaded for STP This problem occurs in STP when you:

Offline Computation. 1. Launch STP Offline for PVST From the
Topology Map.

2. Go to Reports >VLAN STP
Recommendations > STP Offline

3. Click Select Instance
No VLANS are loaded.

Devices not supporting
CISCO-STP-EXTENSIONS-MIB will not support
any STP related functionality.

Workaround:

None.

CSCsa09288 STP protocol based indexing |In STP, configuring Port STP instance parameters
configuration applies to all like Port Priority and Port Cost using STP protocol

instances. type indexing configures the values for all instances.
Workaround:
None.
CSCsa09287 Cannot map VLANS to In STP, if the device is running STP type as MIST,
instance if the device runs configuring the instance to VLAN mapping from
MISTP. STPConfiguationReport > InstanceTab will not be

applied on the device.
This is due to an SNMP Agent problem.
Workaround:

None.
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Table 11 Spanning Tree Protocol Known Problems (continued)
Bug ID Summary Explanation
CSCin67279 Community suffix supportis |In STP, community suffix support is not available for
not available for MST on MST and MISTP on Cisco I0OS switches.
Cisco IOS switches. Workaround:
None.
CSCed72194  |MST device report does not In STP, MST device report may not report the CIST

report CIST root correctly.

root properly.

This is because the dot1dStpDesignatedRootCost
object corresponds to external root path cost. Hence
the value of the object is O for all switches in the
MST region, which contains CIST root.

Workaround:

None.

Resolved Problems

The following table lists the problems resolved since the last release of Campus

Manager.

Table 12 Resolved Problems

Bug ID Summary

Additional Information

CSCin34586 Admin user could not recreate
top level System Defined Group
or User Defined Group but was

allowed to delete these groups.

This problem has been resolved.

CSCin22400 Campus could not add deleted
members, after moving out of
step 3 in the Topology Groups

wizard.

This problem has been resolved.
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Table 12 Resolved Problems (continued)
Bug ID Summary Additional Information
CSCdw05781 |Inconsistency existed in the map |This problem has been resolved.
display of some of the switches
(non-VTP aware ones) under the
VTP domain category.
CSCds81070 IP phone entries in User This problem has been resolved.

Tracking Main Table did not
contain subnet information,

Topology Services

CSCsall1230

When a port was part of channel
and configured as trunk, Campus
did not display the port as
trunking for Catalyst 2950
Switches.

This problem has been resolved.

CSCin34249

Write to startup config did not
work for some devices running
Cisco IOS release 11.2 in VLAN
Port Assignment.

This problem has been resolved.

CSCin25679

The icon for Ether Channel was
not available in Visio Stencil.

Hence Campus displayed an
error message, when a map
containing Ethernet Channel
links was exported and opened in
Visio.

This problem has been resolved.

CSCdz82384

Java Console displayed an error
message when you invoked
Topology views from Topology
Groups.

This problem has been resolved.

ANI Server

CSCdw66262

Although sysName was defined,
ANI did not display discovered
devices.

This problem has been resolved.
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Table 12 Resolved Problems (continued)
Bug ID Summary Additional Information
CSCdul0180 |Campus VC trace between This problem has been resolved.

devices over a VP tunnel resulted
in an empty Trace Report.

DEE

CSCsal2341 Unable to get Campus data using |This problem has been resolved.
DEE Servlet Interface
Functionality. This problem
occurred due to change in DEE
servlet command.

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco
also provides several ways to obtain technical assistance and other technical
resources. These sections explain how to obtain technical information from Cisco
Systems.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Release Notes for Campus Manager 4.0 on Solaris
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Documentation Feedback

Ordering Documentation

You can find instructions for ordering documentation at this URL:
http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm
You can order Cisco documentation in these ways:

e Registered Cisco.com users (Cisco direct customers) can order Cisco product
documentation from the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

e Nonregistered Cisco.com users can order documentation through a local
account representative by calling Cisco Systems Corporate Headquarters
(California, USA) at 408 526-7208 or, elsewhere in North America, by
calling 800 553-NETS (6387).

Documentation Feedback

You can send comments about technical documentation to bug-doc @cisco.com.

You can submit comments by using the response card (if present) behind the front
cover of your document or by writing to the following address:

Cisco Systems

Attn: Customer Document Ordering
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance

For all customers, partners, resellers, and distributors who hold valid Cisco
service contracts, Cisco Technical Support provides 24-hour-a-day,
award-winning technical assistance. The Cisco Technical Support Website on
Cisco.com features extensive online support resources. In addition, Cisco
Technical Assistance Center (TAC) engineers provide telephone support. If you
do not hold a valid Cisco service contract, contact your reseller.

[ 78-16394-01
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I Obtaining Technical Assistance

Cisco Technical Support Website

The Cisco Technical Support Website provides online documents and tools for
troubleshooting and resolving technical issues with Cisco products and
technologies. The website is available 24 hours a day, 365 days a year at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com
user ID and password. If you have a valid service contract but do not have a user
ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4
service requests. (S3 and S4 service requests are those in which your network is
minimally impaired or for which you require product information.) After you
describe your situation, the TAC Service Request Tool automatically provides
recommended solutions. If your issue is not resolved using the recommended
resources, your service request will be assigned to a Cisco TAC engineer. The
TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the
Cisco TAC by telephone. (S1 or S2 service requests are those in which your
production network is down or severely degraded.) Cisco TAC engineers are
assigned immediately to S1 and S2 service requests to help keep your business
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts
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Obtaining Additional Publications and Information

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your
business operations. You and Cisco will commit all necessary resources around
the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or
significant aspects of your business operation are negatively affected by
inadequate performance of Cisco products. You and Cisco will commit full-time
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most
business operations remain functional. You and Cisco will commit resources
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product
capabilities, installation, or configuration. There is little or no effect on your
business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is
available from various online and printed sources.

e Cisco Marketplace provides a variety of Cisco books, reference guides, and
logo merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

e The Cisco Product Catalog describes the networking products offered by
Cisco Systems, as well as ordering and customer support services. Access the
Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/

e (isco Press publishes a wide range of general networking, training and
certification titles. Both new and experienced users will benefit from these
publications. For current Cisco Press titles and other information, go to Cisco
Press at this URL:

http://www.ciscopress.com
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I Obtaining Additional Publications and Information

e Packet magazine is the Cisco Systems technical user magazine for
maximizing Internet and networking investments. Each quarter, Packet
delivers coverage of the latest industry trends, technology breakthroughs, and
Cisco products and solutions, as well as network deployment and
troubleshooting tips, configuration examples, customer case studies,
certification and training information, and links to scores of in-depth online
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

® iQ Magazine is the quarterly publication from Cisco Systems designed to
help growing companies learn how they can use technology to increase
revenue, streamline their business, and expand services. The publication
identifies the challenges facing these companies and the technologies to help
solve them, using real-world case studies and business strategies to help
readers make sound technology investment decisions. You can access iQ
Magazine at this URL:

http://www.cisco.com/go/igmagazine

e [Internet Protocol Journal is a quarterly journal published by Cisco Systems
for engineering professionals involved in designing, developing, and
operating public and private internets and intranets. You can access the
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

e World-class networking training is available from Cisco. You can view
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html

This document is to be used in conjunction with the documents listed in the “Product Documentation” section.
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Obtaining Additional Publications and Information

CCVP, the Cisco logo, and the Cisco Square Bridge logo are trademarks of Cisco Systems, Inc.; Changing the Way
We Work, Live, Play, and Learn is a service mark of Cisco Systems, Inc.; and Access Registrar, Aironet, BPX,
Catalyst, CCDA, CCDP, CCIE, CCIP, CCNA, CCNP, CCSP, Cisco, the Cisco Certified Internetwork Expert logo,
Cisco 10S, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Cisco Unity,
Enterprise/Solver, EtherChannel, EtherFast, EtherSwitch, Fast Step, Follow Me Browsing, FormShare, GigaDrive,
HomeLink, Internet Quotient, IOS, iPhone, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness Scorecard, iQuick
Study, LightStream, Linksys, MeetingPlace, MGX, Networking Academy, Network Registrar, PIX, ProConnect,
ScriptShare, SMARTnet, StackWise, The Fastest Way to Increase Your Internet Quotient, and TransPath are registered
trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries.

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the
word partner does not imply a partnership relationship between Cisco and any other company. (0709R)

Copyright © 2005, Cisco Systems, Inc.
All rights reserved.

Release Notes for Campus Manager 4.0 on Solaris
[ 78-16394-01 .m




I Obtaining Additional Publications and Information

Release Notes for Campus Manager 4.0 on Solaris
m. 78-16394-01 |




	Release Notes for Campus Manager 4.0 on Solaris
	New Features
	Path Analysis
	User Tracking
	Discrepancy Reports
	Administration

	Product Documentation
	Related Documentation
	Additional Information Online
	Support Information
	Known Problems
	General Notes and Known Problems
	General Known Problems
	Browser Known Problems
	Path Analysis Known Problems
	User Tracking Known Problems
	Topology Services Known Problems
	ANI Server Known Problems
	Device/Agent Known Problems Impacting ANI Server
	VLAN Port Assignment Known Problems
	Spanning Tree Protocol Known Problems

	Resolved Problems
	Obtaining Documentation
	Cisco.com
	Ordering Documentation

	Documentation Feedback
	Obtaining Technical Assistance
	Cisco Technical Support Website
	Submitting a Service Request
	Definitions of Service Request Severity

	Obtaining Additional Publications and Information



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


